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Abstract 

The ASEC (ATLAS Student Event Challenge) is an educational project which allows the 
students to learn about the elementary particles by studying “events”, the products of 
beam collisions at the LHC. The events are collected by the ATLAS detector and 
displayed graphically using the ATLANTIS package. The students are given the means to 
select and analyse the events on-line, and subsequently present the results and draw 
conclusions. 
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Introduction 
The ASEC (ATLAS Student Event Challenge) is an educational project at the 

frontier of Particle Physics within the framework of the ATLAS Education and Outreach 
project [1]. The ASEC enables high schools students together with their teachers to study 
the fundamental particles of matter and their interactions through the inspection of the 
graphic visualization/display of the products of particle collisions. These products are 
"events" detected by the ATLAS experiment. The high school students become part of 
the ATLAS Experiment by sharing the actual ATLAS events with the experiment’s 
members. The students have access to both real and simulated data, they are provided 
with tools to analyze these events and therefore, are given the opportunity to participate 
in discoveries. 

Past experiences with the QuarkNet [2] and Hands on CERN [3] projects have 
shown that students and teachers are very willing to work with real data and can spend in 
the analysis time intervals ranging from a day up to a few weeks.  

One of the applications of the ASEC would be its development to future 
international Masterclasses [4]. The ATLAS institutions and research centres across the 
word will greatly profit from holding such “Masterclasses”. They can have the form of 
one-day workshops to familiarize the local students with the ATLAS Experiment through 
lectures and demonstrations. Then the students can work on the data and their 
conclusions will be communicated and discussed on-line with other student groups in 
different countries. These students will carry back to their schools and families their 
enthusiasm and act as “ambassadors” of the experiment to a wider public. This way a 
wider audience will be informed of the physics goals being pursued in the LHC and of 
the advanced communication means developed for the international HEP community.  

Some selected students can also be part of teams (including their teachers) which 
could visit CERN or the local institutions for periods of about a week to carry out small 
projects/extensions of the ASEC interacting with the ATLAS physicists in “situ”.  

Overall Structure of the ASEC 
 Students worldwide can have web access to both real and simulated data which 

will be processed through the GRID. The students are able to study and analyse the 
events using the ATLANTIS [5] event display and the ASEC analysis tools. More 
precisely, they can accomplish the following projects:  

• Select the events they wish, from different event streams 
• Display all (or selected events) one at a time 
• Interact and manipulate the event displays  
• Study the traces of the particles in different parts of the ATLAS detectors  
• Tag the selected reconstructed particle tracks, study  their properties and analyze 

them 
• “Look” and analyze new particles by reconstructing them from their decay 

products 
• Summarize the results in presentations which contain substantial event samples 
• Collaborate with students and physicists worldwide, sharing results and 

observations 
• Discover the physics lying in the datasets 



           This way the students, by working on the most advanced techniques used by 
modern particle physics, obtain a better understanding of the interactions between the 
constituents of matter  
            Some parts of the ASEC can also be used by undergraduate and even graduate 
physics students. There are exercises which demand different skills and the coordinator is 
invited to add his/her own ones. Some of the above projects can be accomplished in few 
hours, others could take more time, depending on the number of events and detail one is 
willing to reach. For the high school students, a simpler version of the ASEC has been 
developed (called simplified ASEC sv), see section on Downloads. 

Description of the ASEC 
The ASEC project uses the general framework of the ATLANTIS canvas displays 

to display the events and goes a step further in the reconstruction and analysis of the 
collisions products for educational purposes. 

In order to accomplish the above, four different windows have been created, 
which provide  all the information needed for the project. There are the:  

• Event display Window (the standard ATLANTIS canvas window) 
• Control Window 
• Track list Window  
• Invariant Mass determination Window  

These windows, shown on Figure 1, open all simultanously arranged on a single 
screen when the project is started. Each can be closed/opened as desired. They all close 
together when the invariant mass window gets closed. The main ASEC webpage is: 
http://asec.phy.bg.ac.yu/. 

 

 
                                                                                                                  

Figure 1: The main ASEC screen 



Below, a brief description of each window is given. 

Event display Window 

         This is the standard ATLANTIS canvas window where the ATLAS detectors and 
tracks of the events are drawn. The Event display has a user selectable shape with the 
associated layout set. A layout set is a set of predefined subwindows within the selected 
shape. These subwindows are used to draw pictures and are called event display pads. 
The user may select a shape via the Preferences->Layout menu option of the Menu of the 
Invariant Mass determination Window. The layout set of the selected shape is displayed 
in and controlled via the Window Control of the Control Window. 

Each event display pad has associated with it a projection (Control Window-
>Parameter Control->Projections), an interaction (Control Window->Interaction and 
Window Control) and a parameter set (Control Window->Parameter Control). 

Control window  

The Control Window is used to view and modify the parameters and the 
selections which control the pictures drawn on the Event display window and the tracks 
displayed in Track list Window. In the normal version the Control Window contains the 
following tabs: 

• Parameter Control  
• Interaction and Window Control 
• Output Display 

The Parameter Control provides the functionality for viewing and changing various 
parameters (data selection, cuts, detector, subdetector systems, projections). The 
parameters are combined into a number of groups which are accessed via sub-tabs. The 
tabs are similar to the ones ATLANTIS uses but with modified startup conditions (cuts, 
projections and data selection). 

The Interaction and Window Control part of the Control Window is used to activate an 
interaction in a event display pad, to modify interaction specific control options of the 
activated interaction and to create subwindows, the event display pads.  

The output Display part of the Control window, is used as a preplacement for a standard 
terminal output. It provides information in a more readable format by using multiple fonts 
and colours. 

The simplified version contains only three subwindows (Figure 2): the 
Projection, which provides the choice for the display of the end-view or side-view of the 
Event. The Interaction subwindow, allows zooming or picking on a track in order to 
display its parameters. 



 

Figure 2: The Control window of the simplified version.  

Finally, the Cut subwindow allows a continuous variation of the tranverse 
momentum cut, above which the tracks are displayed in the Event Display Window.  

Track list Window 

In the Track list Window (Figure 3) the energies, momenta and angle parameters 
(phi, cot theta) of all the tracks, above the cut chosen, are displayed. There are four kind 
of tracks which can be picked through the tabs (reconstructed Inner Detector tracks, 
Simulated tracks, Reconstructed Muon Tracks either MuonBoy or by Moore and the 
Simulated Muon tracks). In the simplified version only one kind of tracks, by default, the 
Inner detector reconstructed tracks plus the Muon reconstructed tracks are displayed 
(Figure 4). 

One can load the previous or next event by the relevant buttons. Furthermore, the 
main function of this window is to allow the user to pick the “preferred” tracks and insert 
(or delete) them to the invariant mass determination Window for further analysis.  

 

Figure 3: The Track list window from the normal version. 
 



 
 

Figure 4: The Track list window from the simplified version.  
 

Invariant Mass Determination window 
 

The Invariant Mass determination window (Figure 5) is the main analysis window 
of ASEC. It can be used for the display of the user chosen tracks of each event and values 
of theirs main physical quantities (momentum etc.). For each event the invariant (or 
transverse) masses of combinations of chosen particles are automatically calculated and 
displayed. For the time being there are three kinds of invariant masses formed. The 
transverse mass of a track and the missing transverse energy of the event (called mlv), the 
invariant mass of two tracks (called mll) and the invariant masses of four tracks called 
(mllll). 

 
 
 
Figure 5: The invariant mass determination window. The red rectangular shows the invariant 
mass calculation of four tracks. 
 
           The Invariant Mass determination menu items are the following:  

• File item 
The File menu item is used to perform operations on event files and on theASEC 
project information. Read event displays a dialog window where one can choose 
which event file to read from the local computer or web. With Save/Load/Clear 



ASEC Project one can perform operations on the current table in Invariant Mass 
determination Window and the corresponding events.  

• View item 
Here one can choose the windows to view.  

• Histograms item 
The Histograms item provides a facility to make histograms of the desired 
quantities of the table (momentum, masses etc.). 

• Preferences item 
The Preferences menu item is responsible for customizing the application.  

• Help item 
The Help menu item provides a way to get access to help information.  

 

Preliminary tasks/Background knowledge 
Before starting, the students: 

• Should become familiar with the background information and the ATLAS 
detector, given in the “Read about” section of the ASEC webpage. There, the 
particle physics is very briefly outlined and links are provided for further 
reference. Only the particles which the students will study are defined. Also very 
brief information for the ATLAS detector and subdetectors is given and the 
students are referred to the ATLAS public pages. 

• Should also read the material given in “Basics” section in order to get familiar 
with the aims of the analysis tools and the physics quantities which they will 
measure. Firstly, they are introduced to the idea of a track as a detectable quantity, 
then to the invariant mass of a particle which decays to other particles. Lastly 
come the ideas of the particle width and the missing energy. These are quite hard 
notions for the student to understand. The coordinator can decide if he/she wants 
to omit those, depending on the level of the students and the time available. If 
done so, the exercises have to be modified accordingly. 

• Finally, in order to learn about the different windows of the ASEC project, the 
students should read the how to “Use ASEC” section. 
Here we stress again the fact that the Challenge is quite flexible and that is up to 

the coordinator to decide which experience he/she wants to push through and how deeply 
(detectors, analysis, discoveries etc) in order to modify accordingly the emphasis on the 
necessary background knowledge. 

Below we describe the three different parts of the Challenge together with their 
relevant exercises (more can be added by the coordinator). 

Main parts of the ASEC 

Part I – Working with Single tracks 
All the students need, is the Track list window where all the single track 

information is displayed. The students can choose different kinds of tracks with the 
different tabs or put cuts on the tracks using the "cuts" tab of the Control Window. They 
can also pick tracks from the Event display using the “pick” tab of the Control Window. 
           The students can familiarize themselves with single particles (learning about the 



different detector parts, the matching between different detectors, the methods to identify 
different kinds of particles). This is a mainly “hardware” task and could eventually be 
used by a graduate course on “Detectors/Experimental Techniques”. 

In the download file area, there are some examples of xml files of few (5-10) 
single tracks of muons, electrons, pions and neutrinos. One can load these events and 
look at the detector signatures. The students should also be given directions how to 
recognize the sign of the tracks. 
 
Part II – Working with combinations of tracks and reconstructing the 
Z and W particles masses. Combine tracks to observe and measure 
known particles. 
           This is done using the provided specialized window called Invariant Mass 
Determination Window. The students can pick and insert to this window several tracks 
from the Track List window (no more than four tracks/event).The track(s) are copied  and 
the invariant mass of the combinations, as the tracks are being inserted, is calculated. The 
students can also delete tracks with the "Delete track" button and replace them with 
others. 
           One track inserted: (To be used for the W→lν (neutrino) lepton decays). The 
invariant mass of this track and the missing ET of the event, is automatically calculated 
and displayed under the mνl column.  
           Two tracks inserted: (To be used for the Z→lepton-lepton decays). The invariant 
mass of the two inserted tracks (muons, electrons, one of each etc.) is calculated 
automatically and displayed under the mll column. 

Part III – Discovery of the Higgs particle 
The easiest decays of the Higgs, for the students to look for within the ASEC 

framework, are those to four leptons. For this purpose the students should use the 
Invariant mass determination Window and insert four tracks. They should pick and insert 
to this window the four tracks which they think (from the previous experience) are more 
probable to belong to a possible Higgs decay. Then the four track invariant mass will be 
automatically calculated and displayed in the mllll column. If for some reason the student 
does not "like" the invariant mass of a particular combination of four tracks, then he/she 
can replace (from one to four tracks) with another(s). The window will automatically 
update the invariant mass under the relevant column. 

If enough (more than 10-20 events) are loaded and looked at, then the histogram 
of the mllll can be displayed. If the Higgs particle exists and if the students have picked up 
the right tracks then an accumulation of events around a specific mass (which is 
hopefully the Higgs mass) will become apparent in the histogram as shown in Figure 6.. 
 
 
 



 
Figure 6. A histogram of few generated Higgs particles decaying to four leptons accumulated 
using the ASEC analysis tools 

Exercises  
Some examples are given for each part. Obviously the coordinator can make up 

more. 
Part I 

• The students can investigate the different detector signatures of different 
simulated single particles.  

• The students can learn to distinguish between electrons, muons, photons and 
hadrons from a file of mixed tracks. They can also investigate the effect of the 
“cut” button. 

• The students can learn to associate the Inner Detector tracks with the Muon tracks 
in the case of muons.  

Part II 
• The students can calculate the invariant mass of two tracks using the analytic 

formula (or eventually of 3 or 4 particles). This can be done by copying the 
momentum information in an excel file. They can check their results with the 
numbers calculated in the invariant mass determination window.  

• Examples of these events could be Z’s (and eventually Higgs if we have them but 
wait for the 3rd part!). So by using selection possibilities the students should be 
able to isolate the electrons or muons which are the Z decay products in an event 
picture and then calculate their invariant mass.  

• The students should try to reconstruct the mass of the Z using combinations of 
muon-muon, electron-muon and electron-electron of different or same charge 
tracks. This way they can learn about the charge and lepton number conservation 

• The students can histogram the reconstructed Z mass and the W transverse mass. 
From them, they can try to determine the Z mass and width and compare them to 
the PDG values. This way they can learn about the influence of the experimental 



errors and mass resolution. They can also study the connection between the Z and 
W widths.  

Part III 

• The students can histogram the invariant masses of four muons, perhaps 
separately for four electrons or muons and two muon-two electron combinations. 
They should be asked to calculate the total charge of all the tracks and the average 
masses of each different combination. 

• They can also look at the two track combinations, at the sum of the sign of the 
two particles, at their mass histograms and decide if they observe any 
accumulation around the mass of the previously reconstructed Z particle.  

• Lastly and more complicated: the students can try to reconstruct the ttbar events. 
They can first try to reconstruct the two W’s from their bW decays. They could 
also learn about b’s and the signature of their semileptonic decays. 

Downloads and further help 
  All the executable versions of the ASEC can be obtained from the “Download” 
tab. If there are any problems with the downloads or running the program, please use the 
“Contact us” tab. 
            These is also a tab with “Useful links” where the students can have access to 
different relevant outreach web pages. 
            For installing the most recent running version of the program, click on the upper 
right line of the first or the second (for the simplified version) part. The lower right line 
gives access to older versions. 
            All versions contain a file of few example events. If more events are required, 
then they can be downloaded from the third part. They can also be saved in local PC’s 
and then loaded  by using the “file” -> “read event” tab in the Invariant mass 
determination window. 

GRID usage 
The ASEC program will give the users/students the opportunity to use virtual 

GRID data tools and techniques which provide: 
• Computing resources 
• Data on the GRID (both real and simulated).The data will be processed and kept on 

several streams and the users can select a number of events from one or several streams. 
• Systematized data analysis (metadata) 
• Collaboration tools for reporting their results and having online discussions about 

their conclusions with fellow students and peers. The results can also be presented both 
orally and written through blogs, wiki sites etc. 

 



Summary 
The ATLAS Event Challenge is expected to help students learn about particle 

physics, giving them access to data and the relevant analysis tools worldwide and 
inspiring to them the ideas of international collaboration. 

At the same time the wider public will become aware of the rich LHC program 
and more specifically the ASEC will help to bring special focus to milestone events in the 
start-up of LHC and the ATLAS Experiment.   
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